
8960 Fading with the PXB 
The PXB can connect with an Agilent E5515C/8960 Wireless Communication Test Set to form a complete solution for 
performing faded signal tests on cdma2000®, 1xEV-DO, W-CDMA/HSDPA and GSM/GPRS/EGPRS mobile devices by 
integrating the base station emulation and measurement capability of the 8960 Wireless Communications Test Set with 
the digitally generated channel impairments generated by the N5106A PXB baseband generator and channel emulator. 
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System Requirements 
8960 requirements: 

• Option 004 (Digital Bus) 
• a supported 8960 lab application 

  

PXB requirements: 

• PXB firmware version 1.6 or later* 
• at least one I/O card 
• at least one baseband card 
• N5106A-8FP - Connect to E5515C (8960) 
• N5106A-QFP - Fading with SISO Channel Models 
• N5106A-JFP - Calibrated AWGN (optional/recommended) 

* PXB firmware version 1.5.3 supports only the E6703 lab application. 

 

8960 Lab and Test Applications 
The PXB currently supports the following 8960 Wireless Communications Test Set applications: 

Model Description Firmware Version 

E1962B* cdma2000 Mobile Test App B.16.12 or later 

E1966A* 1xEV-DO Terminal Test App A.11.12 or later 

E1987A* Fast Switch Test App 
Supports: 

• cdma2000 
• 1xEV-DO 

A.10.12 or later 

E6701G GSM/GPRS Lab App G G.01.12 or later 

E6702C cdma2000 Lab App C C.01.12 or later 

E6703C W-CDMA Lab App C C.01.17 or later 

E6706C 1xEV-DO Lab App C C.01.12 or later 



E6785G Fast Switch Lab App G 
Supports: 

• GSM/GPRS 
• cdma2000 
• W-CDMA 
• 1xEV-DO 

G.00.15 or later 

* Requires the 8960 test application's corresponding Option 405 digital bus software license (E1962B-405, 
E1966A-405). The E1987A Fast Switch Test App requires the corresponding Option 405 license to use a 
desired format. 
  

Before setting up a measurement using an 8960, go to http://wireless.agilent.com/rfcomms/refdocs and read the user's 
guide for the appropriate 8960 application. 

8960 Output Power 
If mobile station testing is performed at frequencies that do not have amplitude offsets assigned to them, the test set will 
estimate an amplitude offset based on the nearest settings. This can cause unexpected results in your measurements. 
The recommended approach is to clear all entries in the 8960's RF IN/OUT Amplitude Offset table to prevent any 
undesired amplitude offsets. If you want to use the 8960's Amplitude Offset feature, make sure you fully understand its 
operation before setting up a measurement. For detailed information on Amplitude Offset for 8960 applications, go to 
http://wireless.agilent.com/rfcomms/refdocs and read the Amplitude Offset topic under Measurements for your desired 
application.  

  

8960 Fading Measurement Example  
To get you started with 8960 fading, we've included a measurement example to help you perform a W-CDMA DPCH block 
error rate (BLER) test using one of the PXB's predefined fading profiles and AWGN.    

8960 Fading measurement example 

  

8960 GPIB Connection and Remote Operation  
It is possible to remotely operate an 8960 in a PXB test system environment. To do so, you will need to use Agilent 
"Remote GPIB" interfacing and configure your system as described in the following section on GPIB-only instruments:  

Using GPIB-only instruments in controller-PXB test systems 
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 Agilent 8960 Fading Measurement Example 
  

 

  

The following measurement example performs a DPCH block error rate (BLER) test on a W-CDMA UE (i.e. DUTor MS) 
using an Agilent E5515C/8960 wireless communications test set with the E6785 Fast Switching Lab Application (ver. 
G.00.15 or later), and an Agilent N5106A PXB baseband generator and channel emulator. 

  

1. Configure the Hardware 
Detailed Steps 

1. Connect PXB external reference output to the 8960 10 MHz reference input. 
2. Connect a USB to GPIB converter from the PXB USB port to the 8960 GPIB port. 
3. Connect an LVDS cable from the PXB digital bus port to the 8960’s digital bus port.  

Note: The PXB digital bus port is also the logical port assignment that you will need to select when you 
add the 8960 to the PXB’s list of external instruments. A1 is the default PXB digital bus port, and it is the 
upper-left port looking at the back of the PXB.  

4. Connect a W-CDMA test phone (UE) to the 8960 RF IN/OUT port. 
Note: It’s also helpful to have a DC adapter for the phone so you don’t run out of battery. 

2. Set Up the 8960 
Detailed Steps 

1. Turn on the 8960. Press the SYSTEM CONFIG key immediately after powering on to select an application. 
2. If running the E6785 fast switch lab application, switch to the WCDMA format (SYSTEM CONFIG > 

F2/Format Switch > WCDMA). 
3. Set the cell power to -50 dBm (CALL SETUP > F7/Cell Power). 
4. Set the channel type to 64k RMC (CALL SETUP > F8/Channel Type). 
5. Set the UE Loopback to “Type 2” (CALL SETUP > Call Control 3 of 6 > F6/RB Test Mode Setup > UE 

Loopback Type). 
6. Set the Uplink DTCH RMC CRC Presence to “Used for Data” (CALL SETUP > Call Control 3 of 6 > F6/RB 

Test Mode Setup > Uplink DTCH RMC CRC Presence). 
7. Don’t originate call yet. 

Note: The fader must be enabled and in “Pass Through” mode before setting up a call. Otherwise, the 
call will be dropped as the connection to the PXB is established. 

3. Set Up the PXB 
Detailed Steps 

1. Turn on the PXB. 
2. Add 8960 to external instrument table. 
3. In the configuration browser, under the Fade (ext in) node, select 1 Channel. 
4. Set up the instrument configuration in the block diagram. Click on the triangle in the fist block and select 

the 8960 that you just set up in the external instrument table. Assign this instrument to IO Port A1. Then 
click the Load Configuration button. 



5. Select W-CDMA/Mobile Station/Case 1 fading profile 
6. Set up AWGN 

o Signal To Noise Ratio = 9.00 dB 
o Output MUX = Signal Only 
o AWGN Enabled = ON 

7. Fader Block = Pass Through (Thr) 
8. If the PXB is in Manual calibration mode, you will need to press the Calibrate Power button before 

pressing Play. 
9. Press the Play button 

Note: Now the signal is running thru the fader, but is unimpaired (i.e. just pass thru). Now it is ok to 
setup a call. And then the fading and AWGN impairments can be added. 

4. Verify Basic Unimpaired Operation 
Detailed Steps 

1. On 8960, originate call to verify that the UE connects and signal travels through PXB in Pass-Through 
mode. 
Note: If you are having problems establishing a connection to the phone, make sure the PXB fader block 
is in Pass-Through (“Thr”) mode, and the PXB AWGN Output MUX is set to Signal Only. 

5. Perform DPCH block error rate (BLER) tests 
Repeat the following steps to verify the Block Error Ratio for each DPCH power level value listed in the 3GPP TS 34.121-1 
v8.6.0 specification. 

Detailed Steps 

1.  Set Cell 1 Connected DPCH Level to -13.9 dB (CALL SETUP > Call Control 2 of 6 > F3/Generator Info > 
F3/Downlink Channel Levels > F3/Connected DL Channel Levels > F2/WCDMA Conn DL Channel Levels 
> Cell 1 Connected DPCH Level). 

2.  Open the Block Error Ratio Measurement. 
3. Open Block Error Setup to set the desired number of blocks. In this example we will use 2000 blocks (the 

specification calls for 8200 blocks for statistical accuracy, but use a lower number for demonstration 
purposes to avoid long wait times). 

4. On PXB: 
o Set Output MUX to Signal + Noise 
o Switch fader block state from Pass Through to On 

5. Reset the Measurement so it starts again. 
6. Observe the block count. You should see the count slowly update in increments of 500 blocks (this will 

take quite a few seconds). When finished, the 8960 will display the Block Error Ratio results. 
7. Repeat Step 5 using the next DPCH power level in the specification. 

  

                  



Using GPIB-Only Instruments in Controller-PXB Test Systems 
Some instruments used by the PXB may have only a GPIB interface (for example, the Agilent E5515C/8960 Wireless 
Communications Test Set). The PXB can connect to these instruments using its GPIB interface or a USB/GPIB adapter. 
However, the PXB cannot enable its GPIB port to simultaneously control a connected instrument and be controlled by a 
remote test controller. We have outlined two scenarios for connecting GPIB-only instruments in controller-PXB test 
systems. Choose the scenario that best fits your test environment.  

In both scenarios, you will use Agilent “Remote GPIB” interfacing. In the first scenario, the GPIB-only instruments are 
connected directly to the PXB and the test controller accesses them through the PXB. In the second scenario, the GPIB-
only instruments are connected directly to the test controller and the PXB accesses them through the controller using 
“Remote GPIB” interfacing. For both of these scenarios, the test controller must connect to the PXB using a LAN type 
interface. 

  

• Scenario 1: GPIB-only instruments connect directly to PXB 
• Scenario 2: GPIB-only instruments connect directly to controller 

  



Scenario 1 - GPIB-Only Instruments Connect Directly to PXB 
In this scenario, the controller connects to the PXB using LAN, the PXB connects to the GPIB-only instrument using GPIB 
or USB/GPIB, and the controller connects to the GPIB-only instrument using a “Remote GPIB” interface, as shown in the 
following illustration: 

 

* Requires Agilent IO Libraries installed on controller with Agilent VISA as the primary VISA, or access to the Agilent VISA 
instead of the primary VISA for those GPIB-only instruments connected to PXB. 

  

1.1 PXB Instrument Configuration 
Perform the following steps on the PXB instrument: 

1.1.1 Capture Instrument Settings in Agilent Connection Expert 
Open the Agilent Connection Expert (Start -> Programs -> Agilent IO Libraries Suite -> Agilent Connection 
Expert).  

If using GPIB interface, set this interface to be the system controller using the “Change Properties” button, then 
checking the “System controller (recommended)” box. 

 

The Agilent Connection Expert GUI should look something like below, with the instruments appearing on the local 
GPIB interface (most likely GPIB1).  

Write down the PXB hostname shown at the top of the tree. In this example it’s “A-N5016A-00054”. 

Note the “GPIB1” interface properties. Write down the SICL interface ID (here it’s gpib100). If using a USB/GPIB 
interface, the interface name in the GUI would most likely be “USB/GPIB0 (GPIB0)”. The “0” is the GPIB port 
number, and can be different depending on how many GPIB interfaces are installed. The important information is 
the SICL interface ID of the GPIB interface the instruments are connected to. 



Close the Agilent Connection Expert (File -> Exit). 

 

1.1.2 Verify that the PXB Application is Running 
It is important to make sure that the PXB application is running before configuring the controller. When the PXB 
application is running, the siclland.exe process is also running, providing the “Remote GPIB” capability. The PXB 
application automatically launches upon startup or reboot; however, it is safest to make sure the PXB application 
is running by checking for the N5106A PXB application in the Windows application bar. If the PXB application is 
not in the Windows application bar, re-launch the PXB application. 

  

1.2 Controller Configuration 
With the PXB application running on the PXB instrument and the system configured as shown above, perform the 
following steps on the controller: 

1.2.1 Install Agilent IO Libraries 15.5 Suite 
Download from Agilent website (http://www.home.agilent.com/agilent/product.jspx?nid=-
34466.907863.00&lc=eng&cc=US). 

Run the installer. If the user wants NI-VISA to be the primary VISA (if NI-VISA is already installed), make sure to 
select “Custom” in the “Setup Type” dialog, and make sure that “Install Agilent VISA as primary VISA” is not 
checked in the next “Install Agilent VISA” dialog. However, this makes test program access to the remote GPIB 
instrument more difficult. Installing Agilent VISA as primary eases test program access and shouldn’t interfere 
with access to other instruments. 

The rest of the install can proceed with default settings. 
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1.2.2 Set up Remote GPIB Interface in Agilent Connection Expert 
Open the Agilent Connection Expert (Start -> Programs -> Agilent IO Libraries Suite -> Agilent Connection 
Expert). 

Add a remote GPIB interface by right-clicking on “SSDXP65” (this will be the computer name of the computer 
that the Agilent Connection Expert is installed on), then selecting “Add Interface”. 



 

In the GUI opened (as shown below), select “Remote GPIB (via E5820 or Remote IO Server)”, and then press the 
“Add” button. 

 



 

In the “Hostname” field, enter the PXB hostname or select IP address and enter the PXB IP address. 

In the “Interface name on remote host” field, change the name to the host SICL interface ID. For this example, it 
is gpib100. Once these fields are updated, press the “Test connection” button. 

Below is the “Remote GPIB interface – Remote” GUI updated with hostname, SICL name, and connection tested. 

 

Close this window by pressing “OK” button. 

Close Agilent Connection Expert (File -> Exit). 

  



Scenario 2 - GPIB-Only Instruments Connect Directly to Controller 
In this scenario, the controller connects to the PXB using LAN, the controller connects to the GPIB-only instrument using 
GPIB or USB/GPIB, and the PXB connects to the GPIB-only instrument using a “Remote GPIB” interface, as shown in the 
following illustration: 

 

*Requires Agilent IO Libraries installed on controller but Agilent VISA doesn’t have to be the primary VISA. 

  

2.1  Controller Configuration 
With the system configured as shown above, perform the following steps on the controller: 

2.1.1 Install Agilent IO Libraries 15.5 Suite 
Download from Agilent website (http://www.home.agilent.com/agilent/product.jspx?nid=-
34466.907863.00&lc=eng&cc=US). 

Run the installer. If the user wants NI-VISA to be the primary VISA (if NI-VISA is already installed), make sure to 
select “Custom” in the “Setup Type” dialog, and make sure that “Install Agilent VISA as primary VISA” is not 
checked in the next “Install Agilent VISA” dialog. 

The rest of the install can proceed with default settings. 
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2.1.2 Capture Instrument Settings in Agilent Connection Expert 
Open the Agilent Connection Expert (Start -> Programs -> Agilent IO Libraries Suite -> Agilent Connection 
Expert). The Agilent Connection Expert GUI should look something like below, with the instruments on the local 
GPIB interface (most likely GPIB0). 

Write down the controller hostname shown at the top of the tree. In this example it’s “SSDXP65”. 

Note the “GPIB0” interface properties. Write down the SICL interface ID (here it’s gpib0). If using a USB/GPIB 
interface, the interface name in the GUI would most likely be “USB/GPIB (GPIB0)”. The “0” is the GPIB port 
number, and can be different depending on how many GPIB interfaces are installed on the controller. If a GPIB 
interface card was installed in the controller, then the USB/GPIB interface added, the USB/GPIB name would 
most likely be “USB/GPIB (GPIB1), and the SICL interface ID gpib1. The important information is the SICL 
interface ID for the GPIB interface the instrument are connected to. 

Close the Agilent Connection Expert (File -> Exit). 

  

 

  



2.1.3 Start the Agilent Remote IO Server 
Start the Agilent Remote IO Server (Start -> Programs -> Agilent IO Libraries Suite -> Utilities -> Remote IO 
Server).  A DOS window opens. You can minimize this window, but do not close it. The Remote IO Server can be 
started automatically at boot up through the Agilent Connection Expert (Tools -> Remote IO Server -> Configure: 
select “Auto-start remote IO server on machine startup”, press OK to close). If started automatically, there isn’t a 
DOS window opened. 

 

  

  

2.2  PXB Instrument Configuration 
Perform the following steps on the PXB instrument: 

2.2.1 Set up Remote GPIB Interface in Agilent Connection Expert 
Open the Agilent Connection Expert (Start -> Programs -> Agilent IO Libraries Suite -> Agilent Connection 
Expert). 

Add a remote GPIB interface by right clicking on “A-N5106A-00054” (this will be the computer name of the PXB 
that Agilent Connection Expert is installed on), then selecting “Add Interface”. 

 

  



In the GUI opened (as shown below), select “Remote GPIB (via E5820 or Remote IO Server)”, and then press the 
“Add” button. 

 

 

In the “Hostname” field, enter the controller hostname or select IP address and enter the controller IP address. 

In the “Interface name on remote host” field, change the name to the host SICL interface ID. For this example, it 
is gpib0. Once these fields are updated, press the “Test connection” button. 

Below is the “Remote GPIB interface – Remote” GUI updated with hostname and SICL name, and connection 
tested. 



 

Close this window by pressing “OK” button. 

Close Agilent Connection Expert (File -> Exit). 

  


